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NEScom
NEScom Software License Agreement
Carefully read this license agreement before opening this software or using NEScom Software.
Opening the sealed packet containing the software or using the software indicates acceptance of this license
agreement. If the terms are not acceptable, contact Thermo NESLAB Customer Support at
1-800-258-0830 or 1-603-436-8411.
Ownership
NEScom Software programs and all accompanying materials are owned by Thermo NESLAB. They are
protected by United States copyright laws, by laws of other nations, and by international treaties.
License
Thermo NESLAB licenses each copy of the NEScom Software for a single computer. Load NEScom into
permanent memory of only one computer and only use that copy on that same computer. Do not install
NEScom Software on a network.
Use and Transfer Restrictions
Do not copy NEScom Software except when making one copy for backup or archival purposes. Transferring
the NEScom Software to a single hard disk is allowed provided the original is kept solely for backup, or
archival purposes. Do not copy any of the written materials. Do not transfer, or assign the NEScom Software
to any another user.
Do not reverse engineer, de-compile or disassemble the Software.

About NEScom
NEScom Windows application provides a means for querying and controlling Thermo NESLAB products over
an RS-232 connection. The application bases all actions on controller icons. Once a controller icon is created,
product parameters can be read and controlled.
Features include the capability to view and print a temperature and setpoint chart, configure and log alarms,
run and save programs, and view indicators in the form of gauges and meters, all from menu bar selections.
NEScom Help will provide answers to the questions that will arise. Use keywords to obtain information in Help
searches. Click on Help buttons for shortcuts to help topics. A glossary of terms is also located in the back of
this manual.

Installing NEScom
The setup program installs NEScom and a run-time engine onto your system. Your system should have at least
10 MB disk space. We recommend installing NEScom on at least a Pentium I PC. Your monitor should have at
least 800 x 600 resolution.
To start installing NEScom double click the drive with the NEScom CD in it and then double click the Setup
icon.
Setup allows you to name the installation directory to copy files. Change the destination directories by selecting Change (although we recommend you use the defaults). Once the directory names are approved select
Finish to complete the installation.
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Getting Started
RS-232 Connection & Cables
Thermo NESLAB offers a cable (P/N 083258) to interface your computer to a Thermo NESLAB product. This
3 meter straight through cable has a 9-pin male connector at one end and a 9-pin female connector at the
other end. It will handle the most common configuration which is a PC with a 9-pin male connector and a
newer Thermo NESLAB product with a female 9-pin connector.
Other configurations may require a different cable and/or an adapter. These items are common parts easily
found at most computer stores.
If there is a problem running this product check the cable connections, ensure the Thermo NESLAB product is
powered, and ensure RS-232 communications is enabled. If necessary, check the parameters in Configure
COM port in the Options menu, see page 39. Ensure the protocol being used by NEScom is supported on the
Thermo NESLAB product.

Initialization
Ensure your Thermo NESLAB product is configured for RS-232 operation.
When NEScom is executed for the first time you are prompted to enter your name as the licensee. Then select
OK.
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The program will then indicate the default communication parameters. (The only other time this is required is if
the initialization file gets corrupted.)

Selecting OK with the mouse removes the pop-up message.
The following window appears:
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Getting Started, Example
Ensure the cable is properly connected.
Ensure the Thermo NESLAB unit is configured for external communication and that all its communication
parameters are properly set. Refer to the unit's Instruction Manual.
Select File, then New, then Controller, and then the appropriate controller, for this example HX TC 400.

1(6FRP

The following window appears:
1(6FRP

The HX TC 400 controller icon will have a yellow background color indicating that NEScom is polling the
controller in an attempt to make contact.
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When the background color changes to blue, NEScom has successfully made contact but is not currently
communicating with it.
To enable communication select View Product Panel.

1(6FRP

When the controller background color changes to green and the product panel appears, NEScom is communicating with the controller.
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Clicking either arrow or the Settings button opens the settings panel. The settings panel displays the unit's
current values.

This panel contains the typical Setup Loop settings found in the product. Change one or more settings, then
click the OK or Update button. The change(s) will be sent to the unit. If a setting is rejected by the unit (e.g.,
setpoint out of range), NEScom will beep. If the Update button was clicked, the rejected control will be refreshed to the original value.
NOTE: The purpose of this panel is to change settings, so you must close the panel before working with other
NEScom panels.
All products which have the ability to turn on and off through serial communications, can be turned on and off
with NEScom, except when using the generic NC Protocol selection. Refer to the unit's Instruction Manual.
The remainder of this manual describes the NEScom windows. The windows are addressed in the same
sequence that they appear on the Menu bar: File, View, Program, Alarms, Indicators, Options, Windows,
and Help.

NOTE: Throughout the program, control buttons can be selected using the mouse or by a holding down the
ALT key and then pressing the underlined letter displayed on the button label.
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File
Select File from the menu bar to display the window shown below. This menu allows you to create, open,
delete or save work spaces containing various controller configurations.
1(6FRP

New
The options are Controller or Workspace.

1(6FRP
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Controller
Use Controller to select the desired icon(s). The icon represents the controller.
1(6FRP

Select from the following icon types:
NC Protocol1 - General support for Thermo NESLAB products that support the NC Protocol.
MICROprocessor Bath1 - General support for Thermo NESLAB Microprocessor line of baths (RTE/EX).
MRS-232C / RS-232C1 - General support for Thermo NESLAB Digital line of baths and chillers that utilize the
MRS232C or RS-232C.
RTE 111/211/221/140; EX 111/211/221/411/511 - Support for RTE/EX digital products utilizing the NC Protocol.
EX 250/251
ULT 80/95
HX TC 400
Merlin
RTE 7/10/17/140; EX 7/10/17/35
When creating an icon, if the product has different serial communication defaults other than NEScom's,
NEScom asks if you want to use the product's defaults.

1. See glossary.
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Up to eight (8) icons can be selected to create a workspace. Workspaces can be saved, see below.
1(6FRPG1 (6FRP ?ZRUNVSDFHQHV

Select an icon with the mouse to make it active. An icon is active if it is highlighted. All menu selections are
now based on the active icon.
The background color of the active icon signifies its communication status.
Yellow - NEScom is polling the device in an attempt to make contact.
Blue - NEScom successfully contacted the device but is not currently communicating with the product.
Green - NEScom is currently communicating with the product.
Red - an error in communication occurred. Communication is resumed by manually enabling communications. See Properties in ths section, or Enable Communications in the Options section.
Workspace
Select this option to define and configure a new workspace. A Workspace is made up of one or more controller icons. If one is already active, NEScom will prompt you to save the current workspace before a new one is
defined or loaded.
All icons are cleared when a new workspace is created. Once new controller icons are added, the workspace
can be saved.
1(6FRP

Icon properties are saved when saving a workspace. If a program is in memory and has been saved to a file,
then this file name is saved with the icon properties and restored whenever a workspace is opened.
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Open
Select this menu item to open a previously saved workspace.
File name:
Type the file name in the space provided or select from the choices within the file list.
Files of type:
The default file type listed is *.nes. To list all files in the directory click on the down arrow and select All files
(*.*).
Directory History:
Choose from the default directory or browse through the directory structure.
Look in:
Choose from the default drive or select from other drive choices.

D:\NEScom30
NEScom30
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Properties
Select Properties to view the window below. Properties include: Description, Location, Communications
Protocol, Read Only status, and Password.

Description: If desired, enter a new description of the unit selected to communicate with NEScom. This
description will appear on the icon and any window panel associated with this icon. The description is referenced when logging alarms.
Location: Enter the physical location of the unit (building, lab
number ...) selected to communicate with NEScom. The location is referenced when logging alarms.
Communications: DisabledEnabled This control is available only when there is a communication error.
Under error-free operating conditions this control is dimmed and gives the status of communications. If an
error occurs which causes communications to stop, communication is re-enabled by setting the switch to
Enable.
NOTE: Communication is normally disabled when NEScom is not requesting parameters from the product.
Once you configure NEScom to request data from the product, communication is automatically enabled.
Comm. Protocol: This displays the current communications protocol. This display cannot be changed.
Read Only: NoYes When in read only mode, NEScom can only query a product for information and not
perform any intrusive setting of product parameters (like temperature setpoint). Read Only mode is enabled by
entering the correct password and selecting Yes on the Read Only switch.
With Read Only mode selected:
Programs cannot be started.
Setpoint cannot be changed from Product Panels.
Product Panel buttons are disabled.
Password: A password must be entered before the Read Only mode can be enabled. All software is shipped
with the password password as a default. Select Change.... to change your password. Passwords are case
sensitive.
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Delete
Select this menu item to delete the active product icon within the workspace. When an icon is deleted, the icon
created first among those remaining becomes the active icon.
NEScom prompts to confirm the deletion.
NOTE: The shortcut for delete is [Shift]+[Del].

Save
Select this menu item to save the current workspace. If the workspace has not been previously saved then a
dialog box will appear prompting for file information.
File name:
Type the file name in the space provided or select from the choices within the file list.
Files of type:
The default file type listed is *.nes. To list all files in the directory click on the down arrow and select All files
(*.*).
Directory History:
Choose from the default directory or browse through the directory structure.
Look in:
Choose from the default drive or select from other drive choices.

D:\NEScom30
NEScom30
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Save As
Select this menu item to save the current workspace under a new file name.
File name:
Type the file name in the space provided or select from the choices within the file list.
Files of type:
The default file type listed is *.nes. To list all files in the directory click on the down arrow and select All files
(*.*).
Directory History:
Choose from the default directory or browse through the directory structure.
Look in:
Choose from the default drive or select from other drive choices.

Print
Select Print from the menu choices to print a hard copy of a graph of the program in memory, a snapshot of
the strip chart, the product control panel or the contents of the alarm log.
Program: After a Program is created and loaded into memory a hard copy can be made. You can print the
program in the form of a graph or plain text. A Program must be viewed if printing in graph form.
Chart: A chart must be viewed before it can be printed. Only the portion viewed will be printed.
Control Panel: A control panel must be viewed before it can be printed.
Alarm Log: An Alarm Log must be opened before it can be printed. The output of the alarm log goes to the
default printer.

Exit
Select Exit from the menu choices to exit the program. If the workspace has changed since the last save, a
save-message prompt will appear before exiting.
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View
Once NEScom is communicating with the product, select View from the menu bar to view one of three program graphs, strip charts, product control panels and alarm logs.
1(6FRP

NOTE: A check mark to the left of the menu item signifies that the program exists for the active controller icon.

Program
Select Program to view a graphic representation of the current program.
If there isn't a stored program NEScom displays:
1(6FRP

To create a program see Program Menu in the next section.
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Chart 1... Chart 2... Chart 3...
Selecting this menu item, prompts you with a pop-up panel for selecting which chart parameters to view and in
what format to display the data.

NOTE: The Microprocessor Bath and the MRS-232C/RS-232C options have only a Chart 1 option and only 2
parameters: temperature and setpoint.
Depending on which controller icon type is active, the look of the Chart Parameters pop-up panel may vary.
Only those controller icons supporting the NC protocol provide the flexibility of selecting from a variety of
parameters to chart. Of all the parameters supported in the NC protocol, only those parameters supported in
the actual product can be plotted on the chart. Selecting a parameter that is not supported does not affect the
strip chart.
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Parameter 1/Parameter 2/Parameter 3/Parameter 4: Select from the list of parameters. Any parameter not
supported is indicated in the reference text box below the label field. To create a chart, Parameter 1 must
exist. Parameter 2-4 are optional. All parameters on the screen are independent from other charts, including
the log file.
Label: By default, the parameter name appears in the Label field. This field can be edited and is limited to 30
characters. The label appears in the chart legend. Parameter one is the title for the y-axis. The range of the yaxis depends on the values used for all the parameters.
High Value: Enter the upper limit for the parameter.
Low Value: Enter the lower limit for the parameter.
Color: Choose from 16 color choices.
Type: Choose a line style (thin line, thick line, or plotted points).
Graph Title: Enter a description of the graph.
After filling out the screen click OK to display the chart.

Time/Div: This selects the time interval for the x-axis divisions. There are always 24 divisions displayed along
the x-axis. This time is in seconds unless the intervals are greater than five seconds. In this case the time
scale for the x-axis is in minutes.
Log File : Select this to output data acquisition to a file. The file contains a column for time and a column for
each parameter being sampled. Time is in seconds and starts with zero. The Log Interval is configurable,
select 1, 10 or 60 seconds (sec). Parameter headings are automatically logged to the file when it is first
opened and data is written to the file as long as it is open.
When Log File is clicked the window changes to Close File. Close the file by clicking on Close File or by
closing the chart panel.
Close: Select this to close the chart panel. The operator is warned that the log file will also close (if open).
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Setup: Select this to bring up a panel for choosing which chart parameters to view and in what format to
display the data.
Print: Select this to print the chart panel to a selected printer or to file. The chart can also be printed from the
File menu. To print the graph at a later time, type the following at the DOS prompt: copy <filename> lpt1.
NOTE: A chart must be viewed in order to be printed.
Help: Select this to display this help topic.

Product Panel
Select Product Panel from the View menu to view the control panel
of the active product icon. NOTE: All features of the product panel
are disabled in the read-only mode. If attempting to perform a function
that requires disabling read-only mode, you will be prompted with a
message or a beep indicating that the unit is in read-only mode.
For an example of a product panel see Getting Started, Example on
pages 4 and 5.
Generic Product Panel:
All Generic controller icons share a generic product panel which
displays temperature and temperature setpoint. The temperature
setpoint can be updated when read-only is disabled. This is done by
entering a number in the New Setpoint field and clicking on the
Update button.

Alarm Log
Select Alarm Log from the View menu to view the contents of the alarm log in a pop-up window panel. An
alarm log file must be opened in order to be viewed. Scroll through the alarm log with the vertical and horizontal scroll bars.
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Program
NEScom provides a means for programming temperature setpoints over time. Setpoint ramp and soak functions are entered as program steps. Any sequence of steps can be repeated up to 999 times with the programloop feature.
1(6FRP

Program Parameters...
Programs are built/edited, viewed and controlled using the Program Panel window. The panel is divided into
the Program Edit Window (top), the Program View Window (bottom) and the Program Panel Buttons (side).
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Program Edit Window
Program steps are defined by their step number. Use this window to enter program steps. Adding, inserting,
deleting and replacing steps is accomplished by first choosing a step number.

Step: Up to 100 steps can be entered starting with step 1.
Begin Temp: Enter the beginning temperature of the program step.
End Temp: Enter the ending temperature of the program step.
Time (min): Enter the duration of the program step in minutes.
NOTE: Setpoint soak is achieved by setting the start and end temperatures to the same value. Soak time is
the period of time entered here. Once a step is completed, the program resumes to the next step in the
program unless # Loops, see below, is set greater than zero. The maximum duration for a single step is
9999.9 minutes.
# Loops: A sequence of steps can be repeated to create a program loop. A number other than zero entered in
this field equals the number of times a sequence of steps is repeated. When a program encounters a nonzero
number for # Loops, it will go to the step number entered in Loop To Step and repeat this action as many times
as indicated. Once the number of loop repeats is reached, the program resumes to the next step in the normal
sequence of the program. A loop can repeat up to 999 times.
Final Soak: The temperature that will be maintained once the program is completed or manually stopped.
Program complete indicator: Select this to get a pop-up message to indicate a complete program.
NOTE: If a communication time-out occurs, the setpoint will remain at the last setpoint.
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Add: After all parameters are entered into a program step, click Add to add this step into the program.
Insert: Inserts a program step into the program. The step number of the inserted step, as indicated by the
Step value, remains the same and all step numbers greater than or equal to the inserted step number are
incremented by one. When a step is inserted within a loop, the Loop To Step value for that loop is not
changed. When a step is inserted prior to a loop, the Loop To Step value for that loop is incremented by one.
Delete: Deletes a program step from the program, as indicated by the Step value. All step numbers greater
than or equal to the inserted step number are decremented by one. When a step is deleted within a loop, the
Loop To Step value for that loop is not changed. When a step is deleted prior to a loop, the Loop To Step
value for that loop is decremented by one.
Replace: Replaces the program step previously entered with the current program step.
Program View Window
This view-only portion of the window details each programmed step. Scroll the window using the vertical scroll
bar.

NOTE: Highlighting program steps in this portion of the window has no affect on the Program Edit Window.
Program Panel Buttons
OK: Closes the Program Panel.
Clear: Clears the entire program currently loaded.
Open: Loads a program that has previously been saved to a file.
Save: Saves current program to the specified path and file name.
View: Displays a graphic representation of the current program. See page 28.
Start: Starts the program. When communication is established the program begins executing
and the controller icon turns green. NOTE: The Program Panel will disappear. Click Program
and then Program Parameters... to display the Program Panel. The Start button changes to
Stop on the program panel when the program is running.
Stop: Stops the program. Under conditions of normal program termination (stopped by the operator or completed as intended) the setpoint will be set to Final Soak. The Stop button on the Program panel changes to
Start.
Help: Displays this help topic.
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Start Program (Ctrl+A):
This menu selection is available only when a program has been stored in memory. This selection starts the
program at the first program step. When the program is running, the controller icon is highlighted green
indicating that communication is established.
1(6FRP

If the program is successfully executing, this menu selection becomes unavailable to the operator and the
Stop Program and Pause Program selections become available. The program control button on the program
panel changes from Start to Stop.
NOTE: If communication fails the icon is highlighted in red.

Stop Program (Ctrl+O):
This menu selection becomes available once a program is stored in memory and started. Selecting this menu
item stops the program. When stopped manually, the program sets the setpoint to the Final Soak value. The
Stop button on the Program panel changes to Start when a program is stopped.

Pause Program (Ctrl+U):
This menu selection becomes available once a program is stored in memory and started. Selecting this menu
item pauses the program. When paused, this menu item is checked and the program does not set the setpoint to any new values. To resume execution of the program, select Pause again. A check mark at this menu
item signifies that the program is paused. The program can be stopped when paused.
View Program: Displays a graphic representation of the current program. The program buttons work in the
same manner as the Program Panel Buttons.
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Alarms
NEScom can be configured to generate warning messages when alarm conditions occur. Alarm setup can
vary depending on which communication protocol is in use. All alarms can be enabled or disabled with a
single menu selection.
1(6FRP

Alarm Parameters
Select any alarm from the menu. The descriptions Alarm 1, Alarm 2, etc. are default names which can be
modified when configuring an alarm.

Alarms are configured by first selecting a specific parameter from a list of ones supported, then entering a high
limit and low limit for that parameter. Parameter units and precision match those of the actual product.
High limit and low limit alarms can be later enabled or disabled by recalling the alarm from this menu. A check
mark on an alarm description signifies that either limit or both limits are enabled.
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Parameters: Select the alarm parameter. If the parameter is not supported by the product then the reference
field will read Not Supported.
Title: Enter a descriptive title for each alarm. This will appear as the new description for this menu item.
High Alarm: Enter the high limit. The alarm will activate when the parameter in question exceeds this limit.
Low Alarm: Enter the low limit. The alarm will activate when the parameter in question is lower than this limit.
Enable: Individually enables or disables each alarm.
Cancel: Cancels all changes made since the last save.
OK: Confirms the alarm configuration.

Enable All
Enables all defined alarms. See Alarm Parameters for individually enabling alarms.

Disable All
Disables all defined alarms. See Alarm Parameters for individually disabling alarms.
When an alarm occurs, you are prompted with a pop-up message. This message displays the alarm description, the value read from the product and the alarm limit. Messages also display the icon description and
location entered under icon properties. You must acknowledge this message and then have the option to
disable the alarm.
NOTE: In all cases an alarm point is stored within the Windows application and is independent of any alarm
setting in the product. For instance, a high-temperature alarm created here will not affect the product's hightemperature alarm setting.

Log Alarms...
NEScom provides the means to log all alarm messages to a file. Select this menu item to create a log file. A
file selection dialog box allows the operator to easily open a file for automatic logging. A check mark on this
menu item signifies that an alarm log has been opened. Selecting this menu item with a check mark closes
the alarm log.
Alarm log entries are stamped with the date and time of the alarm occurrence and the contents of the alarm
message. The alarm log also indicates when an alarm was acknowledge.
View the contents of the alarm log by selecting Alarm Log from the View menu.
Print the contents of the alarm log by selecting Print from the File menu.

- 26 -

Indicators
Indicators are graphical representations of data. Graphical formats such as gauges, thermometers and meters
are linked to product parameters for greater visibility. An indicator is created by selecting the specific indicator
from the menu. A check mark on the indicator menu item signifies that the indicator exists. Selecting a
checked menu item deletes the indicator.
1(6FRP

All indicators reside in an indicator widow. The sizable window is displayed when the first indicator for a
controller icon is created. There is a unique indicator window for each controller icon. Indicators are dimmed
for all controller icons other than the selected active icon.
Indicators can be moved within the indicator window with the mouse or the cursor keys and sized with your
keyboard's +/- (overall adjust), W/w (width adjust), or H/h (height adjust) keys.
Left-Double-Click an indicator to configure the indicator range and title.
Indicators are outlined in red when they are out of range.
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NC Protocol Parameters
The following window is displayed when any Indicator is selected:

The NC protocol is designed to acquire all possible parameter values from Thermo NESLAB proprietary
controllers. Most (if not all) products supporting the NC protocol use only a subset of the entire function set.
When linking an indicator or chart parameter to a protocol parameter for a given product, only those parameters supported by the product are possible parameter choices.
Supported Parameters:
Temperature 1

Supported Alarm Points:
Temperature 1 (high low)

Temperature 2

Temperature 2 (high low)

Setpoint 1

Flow 1 (high low)

Flow 1

Flow 2 (high low)

Flow 2 (future expansion to Flow 10)

Resistivity 1 (high low)

Resistivity 1

Resistivity 2 (high low)

Resistivity 2

Microprocessor Protocol
NESLABs Microprocessor line of products provide temperature, setpoint, high limit and low limit values. Here,
the thermometer indicators are linked to temperature and setpoint and the gauge indicators are linked to the
temperature limit values.
MRS232C Protocol
Products supporting the MRS232C protocol only provide temperature and setpoint values so two thermometer
indicators are available.
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Gauge
NC Protocol
When selecting either 1 or 2 from the Gauge menu item, the operator will be prompted to link a NC protocol
parameter to the indicator.
Parameters: Choose a parameter from the list choices. Parameters that are referenced as Not Supported will not be linked to an indicator.
Label: Type a label for the indicator.
High Value: Enter a high value for the indicator.
Low Value: Enter a low end for the indicator.
Values outside the entered range make the indicator go out of range. This is
illustrated by a red outline on the indicator.
Microprocessor Protocol
High Temperature
Low Temperature
MRS232C Protocol
Not Supported

Thermometer
NC Protocol
When selecting either 1, 2 or 3 from the Thermometer menu item, the operator will be prompted to link a NC
protocol parameter to the indicator.
Parameters: Choose a parameter from the list choices. Parameters that are
referenced as Not Supported will not be linked to an indicator.
Label: Type a label for the indicator.
High Value: Enter a high value for the indicator.
Low Value: Enter a low end for the indicator.
Values outside the entered range make the indicator go out of range. This is
illustrated by a red outline on the indicator.
Microprocessor Protocol and MRS232C Protocol
Temperature
Setpoint
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Meter
NC Protocol
When selecting either 1, 2, 3 or 4 from the Meter menu item, the operator will be prompted to link a NC
protocol parameter to the indicator.
Parameters: Choose a parameter from the list choices. Parameters that are
referenced as Not Supported will not be linked to an indicator.
Label: Type a label for the indicator.
High Value: Enter a high value for the indicator.
Low Value: Enter a low end for the indicator.
Values outside the entered range make the indicator go out of range. This is
illustrated by a red outline on the indicator.
Microprocessor Protocol and MRS232C Protocol
Not Supported

Tank
NC Protocol
When selecting the Tank menu item, the operator will be prompted to link a NC protocol parameter to the
indicator.
Parameters: Choose a parameter from the list choices. Parameters that are referenced as Not Supported will
not be linked to an indicator.
Label: Type a label for the indicator.
High Value: Enter a high value for the indicator.
Low Value: Enter a low end for the indicator.
Values outside the entered range make the indicator go out of range. This is
illustrated by a red outline on the indicator.
Microprocessor Protocol and MRS232C Protocol
Not Supported
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Status
Select Status from the Indicator menu bar to view a products predefined status conditions. Status flags
indicate faults, warnings and other system conditions, and typically vary from product to product. Reference
the product owners manual for the definition of status bits.

NC Protocol
Up to 48 status fields can be predefined for a product. These fields are labeled for specific products that report
their status. When viewing status for a Generic NC icon, the operator will see that the labels for the status
fields are generic as well. These labels can be modified by selecting the field and typing the status label name.
Microprocessor Protocol and MRS232C Protocol
Not Supported
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Options
Select Options from the menu bar to configure and reset the COM port.
1(6FRP

Enable Communications
The control for enabling communications is available only when there has been a communications time-out
error. Under normal operating conditions this control is dimmed and gives the current communication status.
Enabling communications re-initializes the COM port.
Select this menu item to re-enable serial communications following a communications time-out error. This can
also be done from the properties panel and the communications panel. A controller icon with a red background
signifies that there has been a communications error.
Once the COM port has been re-initialized, the product is polled by NEScom in order to establish contact. A
controller icon with a yellow background signifies that it is polling the product. The icon will remain yellow until
contact is made.
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Configure COM Port...
Select this menu item to configure the comm port.
Communication is normally disabled when NEScom is not requesting parameters from the product. Once you
configure NEScom to request product data communication is automatically enabled.
Select the Default button to set suggested RS-232 settings for the protocol in use.

 NC Protocol: 9600 Baud, 8 data bits, 1 stop bit, no parity, polling interval 1.0 second.
 MRS232/RS232: 300 Baud, 8 data bits, 1 stop bit, no parity, polling interval 1.0 second.
 MICROprocessor Bath: 4800 Baud, 8 data bits, 1 stop bit, no parity, polling interval 1.0 second.
Start-up configuration: Port: COM1, 9600 Baud, 8 data bits, 1 stop bit, no parity, polling Interval 1.0 second.
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Window
Select Window from the menu bar for arranging icons and restoring window panels.
1(6FRP

Arrange Icons
Select this menu to arrange controller icons in the NEScom main window panel.
Moving an Icon
Icons can be moved within the main window. Clicking on the icon changes the cursor to a pointing finger
cursor. Moving the cursor to the top edge of the icon changes the cursor back to the default style. When the
cursor changes back to the default style, click and drag the icon to move it.

Window Panels
Lists all window panels opened. Click on the window panel description to bring the panel to the front or restore
a panel when minimized. If there are no window panels opened then this section of the menu is empty.
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Help
Select this menu item for help in operating NEScom. Help is based on the menu selections of the program.
Help buttons on various panels provide a shortcut to a help topic. Get to detailed information on a topic by
clicking on help links.
1(6FRP

Contents
The contents of Help is based on the menu bar of NEScom. Selecting this menu item brings up the HELP
utility. Use the Tab key to scroll through the HELP contents or double-click on a topic to view that specific help
screen.

Search for Help...
Search on a Help topic. Start by typing the first few letters of the word to search. Click on a topic within the list
of topics appearing in the text box. Once a topic is selected, click on Display to get help on the topic.

Service
Opens the Service Log window. Use this log to keep track of service issues. Fill in the Name and Description,
then click Add.
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Demo
A mock controller can be used in place of an actual product to demonstrate NEScom features. Select Demo
from the Help menu and a controller box will appear. When a demo-controller is created, the Demo menu item
has a check mark. Selecting this menu item with a check mark removes the demo-controller.
Rather than issuing commands over the communications interface to an actual product, commands are
intercepted and values from the demo controller driver are used. Bring up charts and indicators, run programs
and setup alarms just as if an actual product existed.
First create a product icon, or open a file to restore a previously saved workspace, then bring up the demodriver. A pop-up message will prompt for the temperature units. Select Fahrenheit, Celsius or Cancel.

Turn the DEMO ON!
You interact with the demo just like an actual product. Switch the ON/OFF switch to the ON position. The
temperature follows the setpoint within a half of a degree of error. With the switch in the OFF position you can
manually vary the temperature.
The following parameters are available for demonstration:
ON/OFF: Starts and stops the controller. When the DEMO controller is ON, temperature follows the setpoint
with a small margin of error. This allows you to create and view a program, or view a chart of temperature and
setpoint. With the DEMO controller OFF, you can manually adjust the setpoint.
Temperature Display: Displays the temperature value.
Temperature: Enter a value for temperature or use the controls to vary the parameter.
Setpoint: Enter a value for setpoint or use the controls to vary the parameter.
High Temperature Limit: Enter a value for the high temperature limit or use the controls to vary the parameter.
Low Temperature Limit: Enter a value for the low temperature limit or use the controls to vary the parameter.
Remote LED: Indicates the remote sensor option enabled. See microprocessor bath control panel.
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About NEScom
This displays copyright and license information relative to NEScom. Make reference to this information when
contacting Thermo NESLAB support.
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Troubleshooting
No Contact:
If there is a problem contacting the product check the cable connections and ensure the Thermo NESLAB
product is powered and RS232 communications is enabled.
Check the parameters in Configure COM port in the Options menu. Ensure the protocol being used by
NEScom is supported on the Thermo NESLAB product.

No Control:
Ensure the software is not in the Read Only mode.
With Read Only mode selected:
Programs cannot be started.
Setpoint cannot be changed from Product Panels.
Product Panel buttons are disabled.
The background color of the active icon signifies its communication status.
Yellow means that NEScom is polling the device in an attempt to make contact.
Blue means that NEScom successfully contacted the device but is not currently communicating with the
product.
Green indicates that NEScom is currently communicating with the product.
Red indicates that an error in communication occurred. Communication is resumed by manually enabling
communications. See Properties or Enable Communications.

Can't Turn Unit On/Off Using NEScom:
Only products which have the ability to turn on and off through serial communications, can be turned on and off
with NEScom, except when using the generic NC Protocol selection. RTE 111/211/221/140, EX 111/211/221/
411/511, EX 250, and ULT 80 cant be turned on and off.

Error Messages:
1
2
3
4
5
6
7
8

Bad Command
Bad Data
Bad Checksum
Bad Response
No Response
Bad Transmit
Unknown Error
Unrecoverable Error

Errors 1 through 6 may be caused by one of the following:

Wrong Controller icon selected in File Menu
Wrong baud rate or parameter mismatch
Bad connection - check cables
Wrong COM port selected or possible comport conflict
Command sent from NEScom not supported by the target Thermo
NESLAB product.
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Poor Display:
When Windows 95 is configured for Large Fonts, many of NEScom panels are badly affected. If the labels are
overlapping numeric settings, then there is a good chance that the display is configured Large Fonts. Font
size is configure through the control panel:
Control Panel -> Display -> Settings -> Font Size
A typical setting is "Small Fonts" which is a normal setting (100 %). This configures 10 point Arial at 96 pixels
per inch.
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Glossary
NEScom : Windows application which communicates with supporting Thermo NESLAB products.
NC Protocol: A generic communications protocol designed to acquire parameter values from Thermo NESLAB
products supporting the protocol (5/97).
MICROprocessor Protocol: A communications protocol implemented on NESLABs microprocessor line of
baths and chillers. Supports Delta-Temp.
MRS232C Protocol: Term used to describe the protocol used with NESLABs MRS232C/RS232C apparatus
for RS232 communications on NESLABs digital line of products. Supports Delta-Temp.
Read Only: When in read only mode, NEScom can only query a product for information and not perform any
intrusive setting of product parameters (like temperature setpoint). Read Only mode is disabled by entering
the correct password in the Properties Panel and selecting No on the Read Only switch.
With Read Only mode selected:
Programs cannot be started.
Setpoint cannot be changed from Product Panels.
Product Panel buttons are disabled.
Workspace: A workspace is made up of one or more controller icons. If one is already active, NEScom will
prompt you to save the current workspace before a new one is defined or loaded. All icons are cleared when a
new workspace is created. Once new controller icons are added, the workspace can be saved.
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Software Warranty
The media on which you receive NEScom are warranted not to fail to execute programming instructions, due
to defects in materials and workmanship for a period of 1 year from the date of shipment. Thermo NESLAB
will, at its option, repair or replace software media that do not execute programming instructions if Thermo
NESLAB receives notice of such defects during the warranty period. Thermo NESLAB does not warrant that
the operation of the software shall be uninterrupted or error free.
Thermo NESLAB believes that the information in this manual is accurate. The documentation has been
carefully reviewed for technical accuracy. In the event that technical or typographical errors exist, Thermo
NESLAB reserves the right to make changes to subsequent editions of this document without prior notice to
holders of this addition. The reader should consult Thermo NESLAB if errors are suspected. In no event shall
Thermo NESLAB be liable for any damages arising out of or related to this document or the information
contained in it.
Thermo NESLAB ASSUMES NO RESPONSIBILITY FOR INCIDENTAL, CONSEQUENTIAL, OR OTHER
DAMAGES INCLUDING, BUT NOT LIMITED TO LOSS OR DAMAGE TO PROPERTY, LOSS OF PROFITS
OR REVENUE, LOSS OF THE UNIT, LOSS OF TIME, OR INCONVENIENCE.
The warranty provided herein does not cover damages, defects, malfunctions or service failures caused by the
owner's failure to follow Thermo NESLAB installation or operation instructions.
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NEScom Software Registration
To validate the warranty and to keep you updated, please complete the information and return it to:
Thermo NESLAB
Software Registration
Attention: Marketing Department
P.O. Box 1178
Portsmouth, NH 03802-1178 USA
You may mail this information or fax it to 603 436-8411. Thank you.
Name (First/Last) ___________________________________
Company Name ____________________________________
Company Division or Mail stop _________________________
Street Address _____________________________________
City/Zip ___________________________________________
State or Province____________________________________
Country ___________________________________________
Software Name & Version _____________________________
Date Software Received (Month/Date/Year) _______________
What is your application for using this software product.
_________________________________________________
_________________________________________________
Please comment or give any suggestions you may have regarding this software.
_______________________________________________
_______________________________________________
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